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1. Overview 
This document describes how to install, configure and run the OfficeServ IVR. 
 
1.1 S/W Architecture 
As depicted in the Figure 1, the IVR consists of the five modules.  
 

• Engine: self menu scenario (shortly, scenario) execution and monitoring 
• Scenario Builder: scenario management  
• Call Recorder: call recording 
• Supervisor: web-based configuration and administration 
• System Configuration: IVR system configuration 

 

 

 

 

 

 

 

[Figure 1] Architecture 
 
1.2 Features 
 

Table 1 provides the definition of terminologies used in OfficeServ ACD and IVR 
 

Terminology Definition/Description 

Split Unit of call routing, group of agent with like skill/level 

Group management-purposed pool of splits 

Division management-purposed pool of groups 

Queue 
The place where the calls stay while waiting for the next available agents. Split and 

queue are 1-to-1 mapped 

Queue ID 

(or Split ID) 

Queue (Split) Identifier. For queued call, different wait comfort message can be set per 

queue ID in the RAD or IVR 
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Message ID 

For CLI/DID routing, there’s an option whether to play welcome message before sending 

the call to the destination split. If message ID is configured, the call which satisfies 

CLI/DID routing condition is routed to RAD or IVR to play the greet message. 

Service Code 

When the caller enters DTMF input, IVR determines the service code with which the 

target split to request the agent is determined. The mapping between the service code 

and split is registered in the ACD Supervisor 

Default Split 

System default split where the call without destination split is routed. 

For example, the call with no or invalid queue ID, service code, message ID is routed to 

the default split. 

IVR call Call routed to the IVR to listen to the greeting message message 

IVR queue A pool where the calls routed to the RAD/IVR wait for the available RAD/IVR ports. 

[Table 1] ACD/IVR Terminologies 

 

Three basic routing rules of ACD are the following. 

• CLI: If caller’s number (CLI) is a specific number registered, then route the call to the 

corresponding split. 

• DID: If caller’s dialed number (DID) is a specific number registered as DID routing, then 

route the call to the corresponding split 

• IVR: Pass the call to the IVR to listen to the welcome message and get the DTMF input to 

determine the destination split. 

 

From OfficeServ perspective, there are five ports configured for ACD 

• Trunk port: the port where the customer call to ACD bypasses through 

• ACD gateway port: the port where the customer call to ACD arrives 

• ACD queue port: the port where the customer call waits for the available agents 

• IVR port: the port where the customer call is cared by RAD/IVR for greet message or wait 

comfort message 

• Agent port: the port where the agent phone is configured 

 

A customer call to ACD passes through the trunk port and is transferred to the ACD G/W. If the 

routing rule configured per trunk port needs the IVR/RAD service, the call is transferred to the IVR 

port to listen to the message. If no message service is needed, the call is transferred to the ACD 

queue port to wait for the available agent of the target split. The call waiting in the ACD queue port 

goes to IVR port to listen to wait comfort message at every queue message interval configured per 

split (queue). After finishing the wait comfort service, the call returns to the ACD queue port. When 
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an agent becomes available in the target split, the call is transferred to the agent port (idle 

extension port).  

 

By Definition, the call which isn’t sent to the ACD queue port for agent request is called “IVR call”. 

The call which is sent to the ACD queue port is called ACD call wherever the call is disconnected 

(e.g. call disconnected at IVR port while listening the wait comfort message is classified as “ACD 

call”). The callback request call is classified “ACD call” since the callback request is submitted to 

each corresponding ACD split. 

 

Table 2 describes all routing combinations available on trunk ports. If the IVR is not used with ACD, 

only the first four routing rules will be available.  

 

Routing Description 

CLI If caller’s number is found in the CLI routing list, route the call to the target split. 

Otherwise, route the call to the default split. When the CLI routing is applied, if the 

message ID is available the call is routed to RAD or IVR to play the welcome 

massage before routed to the target split. 

DID If DID number is found in the DID routing list, route the call to the target split. 

Otherwise, route the call to the default split. When the DID routing is applied, if the 

message ID is available the call is routed to RAD or IVR to play the welcome 

massage before routed to the target split. 

CLI → DID If caller’s number is found in the CLI routing list, route the call to the target   split. 

Otherwise, check the DID routing list. If DID number is found in the DID routing 

list, route the call to the target split. If neither CLI routing nor DID routing is 

available, route the call to the default split 

DID → CLI If DID number is found in the DID routing list, route the call to the target   split. 

Otherwise, check the CLI routing list. If CLI number is found in the CLI routing list, 

route the call to the target split. If neither DID routing nor CLI routing is available, 

route the call to the default split 

IVR Route the call to IVR. When the IVR self menu is completed, the call is routed back 

to the ACD split depending on the service code which is determined by the DTMF 

input, or routed back to the specific agent number. If no service code (or agent 

number) is available or valid, the call is routed to the default ACD split.  

CLI → IVR Apply the CLI routing. If CLI routing is not available, apply IVR routing. 

DID → IVR Apply the DID routing. If DID routing is not available, apply IVR routing. 



 

 
IVR V1.5.2.0 Quick Guide (How to Install, Configure and Run) Page 10 

 

CLI → DID → IVR Apply the CLI routing. If CLI is not available, apply DID routing. If DID routing is 

not available also, apply IVR routing.  

DID → CLI → IVR Apply the DID routing. If DID is not available, apply CLI routing. If CLI routing is 

not available also, apply IVR routing. 

[Table 2] Basic Routing Combinations 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[Figure 2] ACD/IVR Call Flow (not up-to-date) 
 

Figure 2 illustrates the call flow between ACD Server, IVR and Agent. When a new call arrives at 

ACD gateway port, if IVR routing is configured, the call is routed the IVR. In the IVR, the target split 
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is determined based on the caller’s input via DTMF digits. Integrated with customer DB, the caller’s 

personal information such as customer ID, customer level, and customer type is searched, 

authorized and transferred to the Agent program.  
 

When new call arrives at the IVR port, the Engine determines its type and triggers the 
corresponding event for processing the call. There are four events triggered based on the incoming 
call type. 

• DEFID: Greet message for IVR routing call from ACD 

• QUEID: Per-split wait comfort message for ACD queued calls 

• MSGID: Per-message-ID Greet message for CLI/DID routing call from ACD 

• OFF HOOK: IVR direct or incoming call from UCD 
 

1.2.1 Engine  
• Various prompt options (See Figure 2) 

o Call types  
 New call WITHOUT target split 
 New call WITH target split thru Message ID determined by CLI/DID 
 Queued call 

o Different messages per CLI/DID/trunk 
o Call routing to VMS (SVMi or IP-UMS) 
o Operable either with ACD1 or UCD 

• TTS (Text-To-Speech) 
• Commercial customer DB integration through ODBC 
• Data transfer to ACD for personalized call service 

o Callback 
o Customer information (customer level, customer ID, etc.) 
o Target ACD queue ID based on DTMF detection 

• Monitoring 
o Port status 
o Call flow  
o DTMF detection  

 
1.2.2 Scenario Builder 

• Two views for scenario  
o GUI View and Code View (XML) 

• Scenario management 
o Create/Modify/Delete 
o Upload to (Download from) DB 

                                                           
1 For playing voice prompts, the ACD can use either of RAD (Recorded Announcement Device) or . 
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• Scenario simulation 
o Compile 
o Debug with break point 

 
1.2.3 Call Recorder 

• Call types 
o VoIP/PSTN  

• Recording method 
o Intrusion  
o Port mirroring (2008 Fall) 

• Recording Type 
o On demand (request upon IVR Supervisor or ACD Agent) 
o Total (2008 Fall) 

 
1.2.4 Supervisor 

It provides web-based configuration, administration and execution of IVR system. 
• Scenario management 

o Create/Modify/Delete 
o Upload to (Download from) DB 

• Engine administration 
o Scenario execution 
o Port monitoring 
o Call statistics 

• Call Recording 
o Recording device configuration 
o Call recording with status monitoring 
o Call record history search 

• System configuration 
 
1.2.5 System Configuration 

• IVR configuration: CODEC, ACD linkage, etc. 
• Switch configuration 
• TTS configuration 
• License management 
• Log management 
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[Figure 3] System Configuration 
 
1.3 General Specification 

• Language: English 
• OfficeServ: 7200 and 7400 (MP V4.21 or above) 
• DB: SQL Server/Express 
• Operating System: Windows NT, XP, 2003 Server, Vista 
• Required S/W: .Net Framework 1.1 or, IIS (Internet Information Server), OfficeServ 

Link V3.0.0.3 (March 10, 2008), OfficeServ ACD V3.1 
• H/W Specification:  

 
1.4 License Policy 

o # switches (2009-2010) 
o # IVR ports 
o # TTS processors 
o # TTS languages 

 
1.5 Organization 
This document is organized as the following. 

Chapter 2. Preparation 
Chapter 3. Installation 
Chapter 4. Configuration 
Chapter 5. Creating IVR Scenario 
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Chapter 6. Running 
Chapter 7. Trouble Shooting 
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2. Preparation 
2.1 MMC for ACD Integration 
Note: The MCP Version should be V4.21 or above. 

MMC Description 

841 Set feature license 

From SIP STACK ALLOW, set # SIP trunk and # IVR/UMS ports 

857 Assign virtual slot to IVR/UMS (usually C4:S9) 

225 For each IVR/UMS ports, set the type (IVR or UMS) 

Note: IVR port number should be greater than UMS port number 

820 Set unique Link ID 

206 Barge-in type // for call recording 

NO BARGE-IN ⇐ WITH (or WITHOUT) TONE 

501 Set the recall time 

• #71 Recall Wait Time: ringing time at source after recall before transferred to 

default operator group 

• #77 Transfer recall time: ringing time at destination before recall 

724 Check the numbering plan 

• Trunk number 

• Station number 

• Virtual extension number 

• IVR/UMS number 

601 Station group setting for ACD G/W, Queue and IVR(UMS) 

Set 5001 for ACD G/W 

• Ring Type: DISTRIBUTED 

• Next Port: 5039 

• Assign members with virtual extension numbers obtained from MMC 724 

• Max simultaneous new calls + 5 

Set 5002 for ACD Queue 

• Ring Type: DISTRIBUTED 

• Assign members with virtual extension numbers obtained from MMC 724 

Set 5039 for IVR 

• TYPE: BI-VMS 

• Ring Type: DISTRIBUTED 

• Assign members with IP-UMS numbers obtained from MMC 724 

701 COS Content (01) - Usable Feature and set  

           19 EXT FWD ⇐ YES 

           23 FORWARD ⇐ YES 

           37 OUT TRSF ⇐ YES   

           38 OVERRIDE ⇐ YES 

  55 SECURE  ⇐ NO 

           66 VM REC ⇐ YES 
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           68 VMS REC ⇐ YES 

830 Set System IP ADDR 

• Set MCP IP address 

• Set MCP G/W IP address 

• Set the CTI Server IP (OfficeServ Link IP) 

• Set IP-IVR Server IP 

831 • Set MGI IP address 

• Set MGI G/W IP Address. 

835 MGI DSP Option Address 

• Set MGI3 – CODEC       E.g. G.729 –20ms 

• DTMF Type ⇐ OUTBAND 

Note G.723 is not supported in IVR 

102 No FWD setting for Agent station 

207 Set ACD G/W, Queue Ports to ‘Normal Port’ (NO ‘VMAA Port’) 

722 For agent station, set one call button (no incoming call while the agent is 

busy) 

 
[Table 3] MMC for ACD/IVR (Single-Switch) 

 
2.2 MMC for UCD Integration 
* V1.5.2.0 doesn’t support the integration with UCD 

 
MMC Description 

206 Barge-in type // for call recording 

NO BARGE-IN ⇐ WITH (or WITHOUT) TONE 

501 Set the recall time 

• #71 Recall Wait Time: ringing time at source after recall before transferred to 

default operator group 

• #77 Transfer recall time: ringing time at destination before recall 

600 OPERATOR GROUP 

• Set the default operator group  

• e.g. 1: 5000  

724 Check the numbering plan 

• Station (extension) number 

• MGI number 

• IVR number 

601 Station group setting for UCD, Default Operator and IVR 

Set 5000 for default operator group 

• Ring Type: DISTRIBUTED 

• Type: Normal 

• Overflow Time (time before transferring to the next group) 
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• Next port: None (the group to transfer next) 

• Group Transfer Time 

• Group busy: Off (in case of all members are busy, whether to consider the group is 

busy or not) 

• Assign members with extension numbers obtainable from MMC 724 

 

Set 5001 for UCD Queue 

• Ring Type: DISTRIBUTED 

• Type: UCD Group 

• Overflow Time 

• Next port: 5000 (default operator group) 

• Group Transfer Time 

• Group busy: On 

• Assign members with extension numbers obtainable from MMC 724 

Set 5039 for IVR port group 

• TYPE: BI-VMS 

• Ring Type: DISTRIBUTED 

• Assign members with IVR port numbers obtainable from MMC 724 

701 COS Content (01) - Usable Feature and set  

           19 EXT FWD ⇐ YES 

           23 FORWARD ⇐ YES 

           37 OUT TRSF ⇐ YES   

           38 OVERRIDE ⇐ YES 

   55 SECURE  ⇐ NO 

           66 VM REC ⇐ YES 

           68 VMS REC ⇐ YES 

830 Set System IP ADDR 

• Set MCP IP address 

• Set MCP G/W IP address 

• Set the CTI server (OS Link) IP 

• Set IVR Server IP 

831 • Set MGI IP address 

• Set MGI G/W IP Address. 

835 MGI DSP Option Address 

• Set MGI3 – CODEC       E.g. G.729 –20ms 

• DTMF Type ⇐ OUTBAND 

Note G.723 is not supported in IVR 

607 UCD group option 

• #0 FIRST MSG: the first message to play in case all the members are busy  

• #1 SECOND MSG: the second message to play in case all the members are busy 

• #2 EXIT CODE: the digit for Message Termination on Digit 

• #3 RETRY COUNT: # repetition for SECOND MSG  



 

 
IVR V1.5.2.0 Quick Guide (How to Install, Configure and Run) Page 18 

 

• #4 FINAL DEST: in case no member is available after playing max SECOND MSG, 

the destination to transfer 

• #6 UCD RECL: MOH (Music On Hold) interval between SECOND messages 

• #7 MOH SOURCE 

• #8 WRAP-UP: transition time for the member before get the new call 

• #11 AGENT PIN #: pin number for the agent to log on the UCD group 

• #12 GBUSY NEXT ⇐ ON 

It determines whether to transfer to the next port without waiting for OVERFLOW 

TIME (MMC 601) in case of all agents are busy. 

[Table 4] MMC for UCD/IVR (Single Switch) 

 
2.3 MMC for Multiple MGI Cards 
 
The following are the MMC checklist for setting multiple MGI cards. 

 
MMC Description 

601 Register all UMS Dial No. (e.g. 8651-8666) to a station group (e.g. 5039) with BI-VMS type 

615 Add all MGI Dial No. (e.g. 3801-3816) to every item in MMC 615 sub-menu USER 

724 Register MGI Dial No. (e.g. 3801-3816) and UMS Dial No. (e.g. 8651-8666) 

806 Check if the switch recognizes all MGI cards 

831 Check the IP addresses of all MGI cards 

835 Check the MGI DSP option CODEC = G.729 -20ms 

[Table 5] MMC for Multiple MGI Cards 

 
2.4 Microsoft IIS 
The MS IIS v5.0 or higher is required to run the IVR Supervisor 

 

 

2.5 .Net Framework   
IVR requires .NET Framework v1.1 or higher. If .Net Framework is installed before IIS then run 
“aspnet_iisreg.exe” which is located in the framework directory under the Windows OS directory, 

 
C:\WINNT\Microsoft.NET\Framework\v1.1.4322\aspnet_iisreg.exe –i 

 
 

2.6 Microsoft SQL Server or Express 
Note: You can skip this section if MS SQL is already running on your system. 
 
This section will describe how to install, configure and run the MS SQL Express 2005. 
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(1) Download and install Windows Installer V3.1 
To download setup, visit http://www.microsoft.com/downloads/details.aspx?FamilyID=889482fc-
5f56-4a38-b838-de776fd4138c&DisplayLang=en 

 
(2) Download and install SQL Express. 
To download setup, visit http://www.microsoft.com/downloads/details.aspx?FamilyID=220549b5-
0b07-4448-8848-dcc397514b41&displaylang=en  
 
(3) During SQL installation, set the Authentication Mode to SQL Server and Windows 

Authentication. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
(4) Allow remote connection 

For more information, visit http://support.microsoft.com/default.aspx?scid=kb;EN-

US;914277 

 
(5) From SQL Server Configuration Manager, set the Start Mode of Server to Automatic. 
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3. Installation 
(1) From IVR folder, double click setup.exe 

 
 
 
 

(2) Click Next 
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(3) Agree with User License Agreement and click Next 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 

(4)  Enter license key and click Next 
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(5)  Check the checkbox to install RealSpeak 4.0 (TTS) and click Next 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(6)  Choose IVR installation folder and click Next 
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(7)  Enter ACD IP (or DNS name) and click Next 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(8)  Enter switch information and click Next 

 
 
 
 
 
 

 

 

 

 

 

 
 
 



 

 
IVR V1.5.2.0 Quick Guide (How to Install, Configure and Run) Page 25 

 

(9)  Wait while IVR is configuring 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(10)  Enter DB instance name, login ID (sa or sa privilege account), and password. 
         For SQL Express, the instance name is SQLEXPRESS. Click Save. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(11)  Click Yes to delete existing IVR Database 
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(12)  Click Yes 

 
 
 
 
 
 
 
 

(13)  Click OK  

 
 
 
 
 

(14)  Click Next to install, modify, repair or remove RealSpeak setup.exe 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  



 

 
IVR V1.5.2.0 Quick Guide (How to Install, Configure and Run) Page 27 

 

(15) Choose RealSpeak setup option 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(16)  Click Install 
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(17)  Click Finish 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(18)  Click Finish 
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(19)  Install RealSpeak 4.0 language pack as many as licensed.



 

 
IVR V1.5.2.0 Quick Guide (How to Install, Configure and Run) Page 30 

 

4. Configuration 
To configure the IVR, from the Programs menu or desktop, start the IVR System Configuration. 

 
 
 
 
 
 

 
From each tab of IVR System Configuration, configure the IVR as the following: 

• System Settings 
o License update 
o Log level settings (0 - 5, 0: NONE, 5: HIGH) 
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• DB Settings: SQL Instance and Login information (ID and Password) 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Switch setting: MCP IP (MMC 830), MGI IP (MMC 831), Link ID (MMC 820) 
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• IVR Engine: ACD Server IP 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Call Recorder: Network Adaptor 
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• TTS (Text-To-Speech): Default language setting and speech speed adjustment. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To adjust the speech rate, click “Speech Test”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter the texts in the text box and press “Play” button. Move the speech rate bar to adjust the 
speech speed.  
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5. IVR Scenario Builder 

This chapter describes how to create an IVR self menu scenario.  

IVR scenario consists of controls where the control is the basic building block of call controls in IVR 

system. One Line Manager control and one On Hook control are mandatory where Line Manager 

receives the call and On Hook control disconnects the call. 

From the Programs menu or desktop, start the IVR Scenario Builder. 

 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

[Figure 4] IVR Scenario Builder 

 

Create the IVR scenario with point-and-drop, copy-and-paste operations.   
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1. Scenario should have Click the control to put into the scenario from the control bar 

2. Drag-and-drop the control. 

3. Each control has its attributes called “property”. Double click the control to open the 

Property window and edit the property.  

 

Table 6 summarizes the controls available with IVR. Table 6 describes the properties common to 

all controls. 

 

Controls Description 

Line Manager 

 

• Receive incoming calls 

• Manage a group of IVR lines (relative number) 

• Option to link with ACD 

• Option to use TTS 

• Configure the customer database used in the scenario 

Split Call 

 

Branch calls to different control depending on  

• CLI 

• DID 

• Trunk number 

• Message ID 

• Queue ID (Split ID) 

Play Prompt 

 

Play voice messages  

Get Digit 

 

Get DTMF input from the caller and associate the DTMF with the ACD Service Code 
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Enabled with ACD 

Agent 

Request 

• Available to calls without associated split (i.e. No Queue 

ID or No Message ID) 

• Send call to ACD split associated with service code or 

ACD Agent 

Transfer 

Request 

• Available to calls with Split ID or Message ID  

• Send call to its corresponding ACD split associated with 

the split ID or message ID 

Callback • Send callback number to ACD 

Send Data 

 

Normal 

• Basically, all calls dropped during IVR self menu is 

counted as “Abandoned Call” in the ACD statistics. 

Exception: Call with “normal call” notification received 

from IVR. 

Transfer 

 

• Disabled with ACD 

• Transfer call to specific extension number 

Calendar 

 

Branch calls to different controls depending on day/date/time 

Find Data 

 

 Validates the DTMF input from a caller or the control property based on the 

record found in the customer DB. 

 Data validation up to 2 fields  

On Hook 

 

Disconnect the call 

[Table 6] IVR Controls 

   

Properties Description 

Control Name Unique control name 

Connection 

 

Specify the next control depending on the event 

• Event: possible event which can occur to the control 

o DISCONNECT: disconnect event 

• Alias: 3-letter short name for event 

• Jump-To-Control: next control to follow 

• Node: See chapter 5.4. 

Comment Description 

[Table 7] Common IVR Control Properties 

 

Node column of Connection property is effective only in case when the next control to jump is Get 
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Digits control. Chapter 5.4 describes the purpose of node field in detail. 
 
5.1 Line Manager 

 
Line Setup tab 

• Receive incoming calls 
• Manage a group of IVR lines (relative number)  

E.g. 1, 3, 4 :  IVR port 1, 3, and 4. 
       1-4   :  IVR ports 1 through 4  

• Check the ACD option to use IVR with ACD 
• Check the TTS option to use TTS 
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Database tab 

• Set the DSN of customer DB to use “Find Data” control in the scenario 
 

 

 

 

 

 

 

 

 

 

 

 

 

Connection tab 

• OffHooK: Incoming call from switch (not from ACD) 
• DEFID: Incoming call from ACD with no Queue ID or Message ID  
• MSGID: Incoming call from ACD with Message ID  
• QUEID: Queued call from ACD with queue (split) ID 
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5.2 Split Call 
 

Mapping Tab 
• Specify the call branching criteria such as  

o CLI 
o DID 
o Trunk number 
o Message ID 
o Queue ID 

 
We recommend to create three types of Split Call control if necessary 

1. Message ID split control following the MSGID event of Line Manager control 
 
 
 
 
 
 
 
2. Queue ID split control following the QUEID event of Line Manager control 
 
 
 
 
 
 
 
 
3. CLI/DID/Trunk Number split control in any necessary places 
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5.3 Play Prompt 
 

Connection Tab 
• Default events: 

o PlayComplete: event which occurs when the playing the voice message is 
completed 

o DigitTerm: event which occurs when the digit is pressed while the voice message 
is playing 

 
Greetings Tab 

• Options 
o Terminate on Digit: Stop playing the voice message if DTMF is pressed (DigitTerm 

event occurs). 
o Queued Message Settings: Different voice messages depending on wait time 

• Voice Messages 
o User prompt: voice message provided as file (mp2, wav) 
o Fixed system prompt: fixed system provided prompt. E.g. digits, letters 
o Dynamic system prompt: dynamic system provided prompt. E.g. time, date, money, 

etc. 
o Text prompt: TTS generated voice messages 

 
Creating voice messages with TTS 
 

1. From the “Greetings” tab, click “Add Prompt” 
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2. From the “Text Prompt” tab, click “New Prompt” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Enter the texts in the text box and click OK. To listen to the voice message, click 
“Play” button. 

 
 

 

 

 

 

 

 

 
 
 
 
4. To adjust the speech speed, refer to the chapter 4, TTS settings. 

 
5.4 Get Digit 

 
Setup Tab 

• Max No of Tries: the maximum number of trials before the invalid digit or no digit event 
handler is invoked 

• Max No of Digits: the maximum number of digits to be collected before terminating digit 
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collection 
• Max Time – the maximum time in second spent to collect the digits 
• Terminate on Digit: digit collection is terminated if the digit specified is pressed 

 
Mapping Tab 

• Generate the mappings between the digit input and the event 
• For each mapping, event name, digit mask and service code (optional – only if interfacing 

with ACD Server) are specified 
• Send To ACD: Check “Service Code” to send the service code of the matching digit mask 

to ACD. 
• Digit Mask 

o The collected digits are compared to the digit masks in the order 
o N: accept only numeric digit input (Note: “N” is case sensitive) 
o $: accept any key input 

 

Connection Tab 
• Default events: 

o Invalid: the event which occurs if the maximum number of trials is reached and the 
caller has given invalid inputs 

o No Digits: the event which occurs when the caller has not entered any digits 
o Retries Over: the event which occurs when the Get Digits control is entered 

through the Error node and the number of trials reaches the maximum 
• Node column: it specifies whether to reset the trial count of next control or not. This field is 

effective only in case when the next control to jump is Get Digits control. If Error, the 
previously attempted trials will be counted as trial count. If Entry, the trial count is reset 
when a call enters into the control. The default is Entry.  

 
Greeting Tab 

• Specify the voice messages to play on  
o Entry 
o Invalid event 
o No Digit event 

• Option:  
o Terminate on Digit: message playing is terminated if any digit is  pressed  

 
5.5 Send Data 
 
Note: Send Data control is enabled only when “Use ACD” option of Line Manager control is 
checked. 
 
Use Send Data control to send the call information to ACD Server.  
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• Agent Request: DEFID call transfer to ACD Split or agent extension 
• Transfer Request: MSGID or QUEID call transfer to ACD Split 
• Callback Notification 
• Simple IVR Call Notification 
 

Mapping Tab 
• Choose the information type to send. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Connection Tab 

• Default events: 
o DONE: the event which occurs when the call transfer to ACD with agent request is 

successful 
o NOTDONE: the event which occurs when the call transfer to ACD with agent 

request fails 
 

5.5.1 DefaultID 
 
Note: Use this control for transferring DEFID calls to ACD Server 
 
Send Data – Agent Request transfers IVR call to ACD Server requesting the agent service via 
Service Code or other extension number.  

 When send Service Code for agent request, IVR can send the customer information also 
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 Do not specify both Service Code and (Non-Agent) Phone Number. 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
5.5.2 MsgQueID 
 
Note: Use this control for transferring MSGID or “QUEID” calls to ACD Server 
 
Send Data - Transfer Request transfers IVR call to one of three targets 

 “22222” if call goes back to ACD split associated with MSGID, QUEID 
 Non-agent phone number (internal or external) 
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5.5.3 Callback  
 
Send Data – Callback leaves callback number to ACD Server. 

 

 

 

 

 

 

 

 

 

 
 
 

• Callback Tel No: Specify the callback number or CLI number 
• Customer ID: Customer ID if available 
• Service Code: Determine the split where the callback is requested. If Service Code is 

invalid or unavailable, the callback is left in the default ACD split. 
 

5.5.4 Normal 
 

Basically, all calls dropped during IVR self menu before queued in ACD Split is counted as “IVR 

Abandoned Call” in the ACD statistics. If the IVR call is dropped with “Normal” call notification to 

ACD through Send Data – Normal, the call is counted as “IVR Normal Call”. 
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5.6 Transfer 
 
Note: Transfer control is enabled only when “Use ACD” option of Line Manager control is 
not checked. 

 
Setup Tab 

• Extension No: enter the phone number (internal or external) to transfer the call 
 
 

 
 
 
 
 
 
 
 
Connection Tab 

• Default events: 
o DONE: the event which occurs when the call transfer to agent extension number 

successful 
o NOTDONE: the event which occurs when the call transfer to agent extension 

number fails 
 

5.7 Calendar 
 
The Calendar control allows the user to specify a holiday or specific schedule and branch the call 
to different control depending on the time settings. 

 
Setup Tab 

• Specify working time 
 
Specific Day Tab 

• Specify working time of specific date 
 
Holiday Tab 

• Mark specific day as holiday 
 
 
 
 
 



 

 
IVR V1.5.2.0 Quick Guide (How to Install, Configure and Run) Page 48 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mapping Tab 
• Add custom schedule with associated time duration 
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Connection Tab 
 
Custom schedule created in the Mapping tab is listed in Connection tab as events. By default, the 
following three events are displayed. 

• WorkingTime: if the call time is within the scheduled working time then WorkingTime event 
handler is invoked. 

• NonWorkingTime: if the call time is outside of working time then NonWorkingTime event 
handler is invoked. 

• Holiday: If the day is configured as holiday then Holiday event handler is invoked. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
5.8 Find Data 
 
The Find Data control searches for a record in the database with one or two fields. This control 
validates the caller’s DTMF inputs or the data collected in other controls against the record found in 
the DB. The databases used to search the record must be configured in advance in the Line 
Manager control. 
 
Setup Tab 

• Use This DSN: Specify DSN configured in Line Manager 
• Use This Table: Specify the table to search the data 
• Use This Field: Specify the field in the table 
• To Match This: Specify the value to validate against the DB record 



 

 
IVR V1.5.2.0 Quick Guide (How to Install, Configure and Run) Page 50 

 

• Second Field: check the checkbox to validate two values 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Connection Tab 

• Default events: 
o FOUND: If the data is valid, then the call exits the control with Found event 
o NOTFOUND: If the date is invalid, the call exits with Not Found event 

 
5.9 On Hook 
 
The On Hook control disconnects the call. 
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6. IVR Engine 

This chapter describes how to operate the IVR Engine.  

From the Programs menu or desktop, start the IVR Engine. 

 
 
 
 
 
 

 
 
IVR Engine program consists of multiple windows  

• Line Detail Window – displays the status of IVR ports (IDLE, BUSY, STOP) 
• Call Detail Window – displays the details of a busy IVR port 
• Call Flow Window – displays the scenario flow of IVR call 
• Output Window – message from Engine (e.g. DTMF touchtone input) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The menus of IVR Engine are the following 
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Menu Description 

Reload Reload IVR scenario  

Open Open IVR scenario from the  folder 

Download from DB Download IVR scenario from DB 

Recent File Recently loaded IVR scenario 

File 

Exit Exit the program 

Toolbar Open/Close Toolbar 

Status Bar Open/Close Status Bar 

Line Detail Window Open/Close Line Detail Window 

Output Window Open/Close Output Window 

View 

Call Detail Window Open/Close Call Detail Window 

Start Start the Engine with scenario 

Stop Stop the Engine 

Update  Dynamic update of currently running scenario 

 Available only when Engine is running Engine 

Switch Status  Displays the switch connection status (CONNECTING, 

STOP, FAIL, ALIVE) 

 Available only when Engine is running 

Help About IVR Engine Version and Date of Engine program, 

[Table 8] Menus of Engine 
 
To run the IVR, do the following 

1. Download the scenario from DB or open from the folder 
2. Check the ACD Server is running if IVR scenario is configured with ACD. 
3. From File menu, start the Engine. If the connection to switch is successful, the IVR 

switch link status changes to LINK: ALIVE. Otherwise, the status changes to LINK: 
FAILED. If connection fails, check the settings of OfficeServ MMC or IVR. 

 
To update the scenario while Engine is running, press “File>Update”.  
 
To stop the Engine, press “File>Stop”. 
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7. IVR Call Recorder 

This chapter describes how to operate the IVR Call Recorder.  

From the Programs menu or desktop, start the IVR Call Recorder. 
 
 
 
 
 
 
 
 
IVR Call Recorder allows the user to register the recording device and browse the recording status 
and history.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Active Recording tab displays the list of current recording calls and call details. Completed 
Recording tab displays the list of recorded files. Table 9 illustrates the menus of Call Recorder.  
 

Menu Description 

File Exit Exit the program 

Recorder Settings Color setting of Call Recorder 

Recording Device Information Register/Edit/Delete recording device 
Edit 

Column Selection Select columns of Active Recording and Stored Recording 

tabs 
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Toolbar Open/Close Toolbar 
View 

Status Bar Open/Close Status Bar 

Help About IVR Engine Version and Date of Engine program, 

[Table 9] Menus of Call Recorder 
 
7.1 Managing Recording Device 
 
The user can register a new recording device in Call Recorder or Supervisor. 

1. open Recording Device Information Window from Edit menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Press New button then Recording Station Configuration Window is displayed. Enter the 
extension number, station type (IP or TDM), IP address, and check the Availability.  
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2. From the Call Recorder page of IVR Supervisor, press “New” button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The user can modify/delete the recording device in Call Recorder or Supervisor 

1. From the Recording Device Information Window, choose the device and press “Edit” 
or “Delete” button. 

2. From the Call Recording page of Supervisor, choose the device and press “Modify” 
or “Delete” button 
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7.2 Recording Conversation 
 
The user can record the conversion in ACD Agent or IVR Supervisor. 

1. While conversation is on-going with Agent phone, press Recording Request button  
 from the toolbar.  

 
2. From the Call Recorder page of IVR Supervisor, choose the device to record the 

conversation and press “Start Record” button. 
 
The Recording status can be monitored in Call Recorder of IVR Supervisor 

1. In the Active Recording tab of Call Recorder, Recording Status column displays “In 
Progress” 

2. In the Call Recorder page of Supervisor, the status icon of the device changes from 
“Red” to “Green”.  

 
The user can stop recording in ACD Agent, IVR Call Recorder or IVR Supervisor. 

1. When conversation is over, call recording stops automatically 
2. In the Active Recording tab of Call Recorder, choose on-going recording and press 

the right-click menu. Select “Stop Recording” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. From the Call Recorder page of IVR Supervisor, choose the device to record the 

conversation and press “Start Record” button. 
 
The user can search or listen to the recording files in Call Recorder or Supervisor 

1. In the Completed Recording tab of Call Recorder, choose a completed recording and 
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press the right-click menu. Select “Play File” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. From the Recording History page of IVR Supervisor, choose the device to play the 

file. 
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8. IVR Supervisor 

The IVR Supervisor allows the user to administer and operate the IVR Engine and Call Recorder. 

The default login ID and password are admin/4321. 
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9. Trouble Shooting 
This chapter describes how to resolve the IVR problems with configuration, component settings 
and Web related settings. 

1. The Engine fails to connect to OfficeServ  

I. Check if the MMC setting of OfficeServ is correct. 

II. Check if the switch setting of System Configuration is correct 

 

 
 
 
 
 
 
 
 

 

 

 

 

 

2. Cannot hear the voice messages 

I. If the scenario voice messages are created with TTS, check if the TTS 
language pack is installed and properly configured in the System Configuration 

II. Using the network packet capture program (e.g. Ethereal), capture the udp 
packets from IVR Server and check if the RTP packets are sent properly to 
OfficeServ.  

3. Unable to start any scenario from the Supervisor. 
Scenario can be started only if the Engine status is displaying green in Engine and 

Scenario web page. If the status is red, then launch the Engine application to start a scenario.  
 

4. Unable to start recording from the Supervisor. 
I. Check if IVR Engine is running 
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II. Check if Call Recorder is running 
III. Check if conversation is on-going with the device 
IV. Check if the Network adaptor is configured properly in the System 

Configuration 
V. Check if MMC 206 and 701 are configured properly 
 

5. In Supervisor, Engine status is showing red even though the Engine application is 
running. 

 OR 

 In Supervisor, Call Recorder status is showing red even though the Call Recorder 

application is running. 

 
By default, security permission for accessing, launching and activating the components 

are not configured for “INTERACTIVE, NETWORK and Everyone” Identities for the logged on 
user. The user needs to set these identities manually by using the program called 
DCOMCNFG. The settings of these identities are explained in step by step as the following. 

 

I. Go to Start » Run command, type “dcomcnfg” and click OK to open the Component 
Services as shown in the figure below: 

        OR 

           From the START menu, select CONTROL PANEL » ADMINISTRATIVE TOOLS » 
COMPONENT SERVICES. 

II. In Component Services, go to Component Services » Computers and right click on My 
Computer then select Properties as shown in the figure below: The user may be 
prompted to keep blocking the program MICROSOFT MANAGEMENT CONSOLE. If 
so, click on the UNBLOCK or ASK ME LATER button. 
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III. In My Computer Properties, go to COM Security tab and click on Edit Default button of 
Access Permissions as shown in the figure below: 
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IV. Add INTERACTIVE; NETWORK and Everyone group names in the Default Security 
tab with all the access permission. To add INTERACTIVE, Click on the ADD button, 
then type in the phrase INTERACTIVE and press OK. Highlight INTERACTIVE then 
check the LOCAL ACCESS and REMOTE ACCESS boxes under ALLOW column as 
shown in the figure below. Repeat the same steps for adding NETWORK and 
Everyone names. 
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V. Adding Launch permission, go to COM Security tab and click on Edit Default button of 
Launch and Activation Permissions  

VI. Add INTERACTIVE, NETWORK and Everyone group names in the Default Security 
tab with all the permissions To add INTERACTIVE, Click on the ADD button, then type 
in the phrase INTERACTIVE and press OK. Highlight INTERACTIVE then check the 
LOCAL LAUNCH, REMOTE LAUNCH,  LOCAL ACTIVATION and REMOTE 
ACTIVATION boxes under ALLOW column as shown in the figure below. Repeat the 
same steps for adding NETWORK and Everyone names: 



 

 
IVR V1.5.2.0 Quick Guide (How to Install, Configure and Run) Page 64 

 

 

VII. Finally, click on Apply and OK of COM Security tab of My Computer Properties. 

 

VIII. Close all running IVR modules (Engine, Scenario Builder, Call Recorder, System 
Configuration and Supervisor) Run Service, from the START menu, select CONTROL 
PANEL » ADMINISTRATIVE TOOLS » SERVICES. Select IPIVRService and restart it.  

IX. The user can start performing web management from Supervisor module.  

 

6. ASP.Net Version confliction with other web application, so Supervisor web pages 
are shows errors.  

 
Usually, this occurs in Windows 2003 Server due to more than one ASP.Net versions are 

available and used by other web application. IVR Supervisor is compatible with ASP .NET 
version 1.1.4322. When IVR package is installed, by default ASP.NET version 1.1.4322 is set 
to the IVR web site. ASP.NET conflicts occur if the any other web site uses other than 
ASP.NET version 1.1.4322.  To resolve this, all the web sites need to be set to use ASP.NET 
version 1.1.4322. The steps are given below for setting the all sites version to 1.1.4322. 

I. Open the Command Prompt, go to the directory 
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“\windows\Microsoft .Net\Framework\v1.1.4322”  

II. Run the “aspnet_regiis.exe –s W3SVC/1/ROOT” command as illustrated in 
the figure below: 

 

7. HTTP Error 404 – File or Directory Not Found – Internet Information Server (IIS). 
This problem occurs in Windows 2003 server due to the settings in the IIS not given the 

permission to execute ASP.Net. To trouble shoot this problem, perform the following steps: 

I. Go to Start » Run command, type “inetmgr” and click OK to open the IIS 
Manager as shown in the figure below: 

II. In the IIS Manager, select the Web Service Extensions and on the right side 
pane set the status of ASP.NET of particular version configured for an web 
application to Allowed as illustrated in the figure below:  
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8. Server Error in ‘/IVRSupervisor’ Application 

    This problem occurs due to the following reasons: 

 

When the requested Page or the directory itself not found in the path on which the Virtual 
Directory “IVRSupervisor” is been configured OR the virtual directory was already present 
configured with different path before installing the setup. 

  To trouble shoot this problem, perform the following steps: 

I. Go to Start » Run command, type “inetmgr” and click OK to open the IIS Manager as 
shown in the figure below: 
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II. Then expand the “Default Web Site”, right click on “IVRSupervisor” virtual directory and 

select properties from the pop-up menu as shown in the figure below: 

 
III. In the “IVRSupervisor properties” window, select the virtual Directory tab (which is a 

default tab when we open the properties window). Make sure that “A directory located 

on this computer” option is been selected and see the path displayed in the “Local 

Path:” textbox is “<IVR Installed Root>\ Samsung Electronics\OfficeServ 

IVR\IVRSupervisor”. If it has configured to some other location then click on browse 

button and map it to the following location “<IVR Installed Root>\ Samsung 
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Electronics\OfficeServ IVR\IVRSupervisor”. As shown in the figure below:  

If “IVRSupervisor” folder not present in the Installed root location then it might have got deleted, so 

reinstall the IVR setup and make sure you delete the existing virtual directory before reinstalling the 

setup. To delete virtual directory right click on the virtual directory “IVRSupervisor” in IIS as shown 

in the figure of step II, and click on delete option from the pop-up menu.  

 

Incase, if “IVRSupervisor” folder exists even then you are facing the problem then IIS 

might have not restarted properly after the IVR setup has completed successfully. So to restart IIS 

follow the below steps and try accessing the web site then it should work fine. 
a) Go to Start » Run command, type “cmd” and click OK to open the Windows 

command prompt as shown in the figure below: 

b) Then type iisreset and press enter key to restart the IIS. As shown in the figure 

below:  
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9.  PrjIVRLicense.dll not registered. 

This problem occurs if the PrjIVRLicense.dll is not registered properly by the setup. To 
troubleshoot this problem follow the below steps: 

I. Go to start-> Run and type the below text: 

regsvr32 “<IVR Installed Root>\ Samsung Electronics\OfficeServ 
IVR\Common\ PrjIVRLicense.dll” 

After typing the above text in run command click on OK button as shown in figure below: 

 

II. After clicking OK button a succeed message should be displayed as shown in the 
figure below: 

 

If succeed message is not displayed and a failed message displayed then you might 
have not entered the path of the dll file properly or make sure the dll file present in the 
directory. If dll file not present in the above specified path then it might have got deleted, 
so you need to reinstall the IVR setup.  

10. Steps to remove the old IVR Database if exists. 

Installer prompts the user to remove the old IVR database during installation process. 
However, if installer is failed to remove the old DB then user needs to remove the old 
Database manually and configure new Database using IVR System Configuration 
application. 

I. Login to SQL server instance using SQL server management studio tool. 
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II. Locate and select the IPIVRDB database, right click and select delete option from the 
pop-up menu to delete the database. 

OR 

I. To delete and configure the IVR Database close all the application to make sure the 
IVR DB is no longer in use and launch the IvrDBConfig.exe application which will be 
present in the following location : <IVR InstalledRoot>\ Samsung Electronics\OfficeServ 
IVR\Common\IvrDBConfig.exe. 

II. After keying the valid server and login details, IvrDBConfig application will prompt the 
user to remove the old IVR Database then select yes to continue deleting the old 
database and create the new one. 

11. Kindly send the following (I-IV are required for all errors) to contact Samsung for 

help with trouble shooting 
 
I. Error description with helpful images/error messages  

A. Caller’s Number 
B. IVR Port Number 
C. ACD Agent Number 
D. ACD Queue Port Number, etc. 

II. IVR Scenario 
III. Increase the Corresponding module’s log level to 5 and send the log 

under %IVR_HOME%\MODULE\log. 
IV. Ethereal log file of IVR Server 
V. If running with ACD, ACD Server log located under %ACD HOME%\Server\log, Link log 

under %LINK HOME%\log and ACD DB 
VI. If the error is related to Recording request from Agent, Agent log under C:\temp 

and %ACD AGENT HOME%\log 

 


